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Information contained in this publication regarding device

applications and the like is provided only for your convenience

and may be superseded by updates. It is your responsibility to

ensure that your application meets with your specifications.
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hold harmless Microchip from any and all damages, claims,

suits, or expenses resulting from such use. No licenses are
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intellectual property rights.
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Note the following details of the code protection feature on Microchip devices:

� Microchip products meet the specification contained in their particular Microchip Data Sheet.

� Microchip believes that its family of products is one of the most secure families of its kind on the market today, when used in the 

intended manner and under normal conditions.

� There are dishonest and possibly illegal methods used to breach the code protection feature. All of these methods, to our 

knowledge, require using the Microchip products in a manner outside the operating specifications contained in Microchip’s Data 

Sheets. Most likely, the person doing so is engaged in theft of intellectual property.

� Microchip is willing to work with the customer who is concerned about the integrity of their code.

� Neither Microchip nor any other semiconductor manufacturer can guarantee the security of their code. Code protection does not 

mean that we are guaranteeing the product as “unbreakable.”

Code protection is constantly evolving. We at Microchip are committed to continuously improving the code protection features of our

products. Attempts to break Microchip’s code protection feature may be a violation of the Digital Millennium Copyright Act. If such acts

allow unauthorized access to your software or other copyrighted work, you may have a right to sue for relief under that Act.

Microchip received ISO/TS-16949:2002 certification for its worldwide 
headquarters, design and wafer fabrication facilities in Chandler and 
Tempe, Arizona; Gresham, Oregon and design centers in California 
and India. The Company’s quality system processes and procedures 
are for its PIC® MCUs and dsPIC® DSCs, KEELOQ® code hopping 
devices, Serial EEPROMs, microperipherals, nonvolatile memory and 
analog products. In addition, Microchip’s quality system for the design 
and manufacture of development systems is ISO 9001:2000 certified.
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Safety Notice

The safety notices and operating instructions provided should be adhered to, to 

avoid a safety hazard. If in any doubt, consult your supplier.

WARNING – This system must be earthed (grounded) at all times.

CAUTION – The system should not be installed, operated, serviced or modified 

except by qualified personnel who understand the danger of electric shock 

hazards and have read and understood the user instructions. Any service or 

modification performed by the user is done at the user’s own risk and voids all 

warranties.

WARNING – The output terminals are NOT isolated from the incoming AC mains 

supply and may be at up to 410V with respect to ground, regardless of the input 

mains supply voltage applied. These terminals are live during operation AND for 

five minutes after disconnection from the supply. Do not attempt to access the 

terminals or remove the cover during this time.

WARNING – The unit may obtain power through the output terminals if these are 

connected to a rotating motor acting as a generator. If this is the case, then the 

previous warning also applies (i.e., the output terminals are live when connected 

to the generator and for five minutes after the generator has been stopped). Note 

that this case can arise even when the unit has been disconnected from the 

incoming AC mains supply.

CAUTION – If a motor is connected to the output of this unit, the frame should be 

connected to the output protective ground terminal provided. Particular care 

should be taken to mechanically guard such a motor, bearing in mind that 

unexpected behavior is likely to result from the process of code development. 

CAUTION – For continued protection against the risk of fire, replace the fuse with 

one of the same type only (i.e., Fast Act Fuse 15A/250 V).
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� The system is intended for evaluation and development purposes and 

should only be operated in a normal laboratory environment as defined by 

IEC 61010-1:2001. 

� Clean with a dry cloth only.

� Operate flat on a bench, do not move during operation and do not block the 

ventilation holes.

� The system should not be operated without all the supplied covers fully 

secured in place.

� The system should not be connected or operated if there is any apparent 

damage to the unit.

� The unit is designed to be connected to the AC mains supply via a standard 

non-locking plug. As the unit has no mains switch, this plug constitutes the 

means of disconnection from the supply and thus the user must have 

unobstructed access to this plug during operation. 
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Preface

INTRODUCTION

This preface contains general information that will be useful to know before using the 

dsPICDEM™ Motor Control High-Voltage (MCHV) Development System. Topics 

discussed in this preface include:

� Document Layout

� Conventions Used in this Guide

� Warranty Registration

� Recommended Reading

� The Microchip Web Site

� Development Systems Customer Change Notification Service

� Customer Support

� Document Revision History

DOCUMENT LAYOUT

This user’s guide describes how to use the dsPICDEM™ MCHV Development System. 

The document is organized as follows:

� Chapter 1. “Introduction” – This chapter introduces the dsPICDEM™ MCHV 

Development System and provides a brief overview of its features.

� Chapter 2. “Getting Started” – This chapter provides information on getting 

started with the dsPICDEM™ MCHV Development System.

� Chapter 3. “Running the Demonstration” – This chapter describes the demon-

stration software that is preloaded on the dsPIC33F device that accompanies the 

dsPICDEM™ MCHV Development System.

� Chapter 4. “Hardware” – This chapter describes the hardware on the 

dsPICDEM™ MCHV Development System.

� Appendix A. “Board Layout and Schematics” – This appendix provides 

diagrams of the hardware layout, as well as schematic diagrams for the 

dsPICDEM™ MCHV Development System.

NOTICE TO CUSTOMERS

All documentation becomes dated, and this manual is no exception. Microchip tools and 

documentation are constantly evolving to meet customer needs, so some actual dialogs and/

or tool descriptions may differ from those in this document. Please refer to our web site 

(www.microchip.com) to obtain the latest documentation available.

Documents are identified with a “DS” number. This number is located on the bottom of each 

page, in front of the page number. The numbering convention for the DS number is 

“DSXXXXXA”, where “XXXXX” is the document number and “A” is the revision level of the 

document.

For the most up-to-date information on development tools, see the MPLAB® IDE on-line help. 

Select the Help menu, and then Topics to open a list of available on-line help files.
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CONVENTIONS USED IN THIS GUIDE

This manual uses the following documentation conventions:

DOCUMENTATION CONVENTIONS

Description Represents Examples

Arial font:

Italic characters Referenced books MPLAB® IDE User’s Guide

Emphasized text ...is the only compiler...

Initial caps A window the Output window

A dialog the Settings dialog

A menu selection select Enable Programmer

Quotes A field name in a window or 

dialog

“Save project before build”

Underlined, italic text with 

right angle bracket

A menu path File>Save

Bold characters A dialog button Click OK

A tab Click the Power tab

N‘Rnnnn A number in verilog format, 

where N is the total number of 

digits, R is the radix and n is a 

digit.

4‘b0010, 2‘hF1

Text in angle brackets < > A key on the keyboard Press <Enter>, <F1>

Courier New font:

Plain Courier New Sample source code #define START

Filenames autoexec.bat

File paths c:\mcc18\h

Keywords _asm, _endasm, static

Command-line options -Opa+, -Opa-

Bit values 0, 1

Constants 0xFF, ‘A’

Italic Courier New A variable argument file.o, where file can be 

any valid filename

Square brackets [ ] Optional arguments mcc18 [options] file 

[options]

Curly braces and pipe 

character: { | }

Choice of mutually exclusive 

arguments; an OR selection

errorlevel {0|1}

Ellipses... Replaces repeated text var_name [, 

var_name...]

Represents code supplied by 

user
void main (void)

{ ...

}
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WARRANTY REGISTRATION

Please complete the enclosed Warranty Registration Card and mail it promptly. 

Sending in the Warranty Registration Card entitles users to receive new product 

updates. Interim software releases are available at the Microchip web site.

RECOMMENDED READING

This user’s guide describes how to use the dsPICDEM™ MCHV Development System. 

The device-specific data sheets contain current information on programming the specific 

microcontroller or digital signal controller devices. Other useful documents are listed 

below. The following Microchip documents are available and recommended as 

supplemental reference resources:

MPLAB® IDE Simulator, Editor User’s Guide (DS51025)

This user’s guide is a comprehensive guide that describes installation and features of 

Microchip’s MPLAB Integrated Development Environment (IDE), as well as the editor 

and simulator functions in the MPLAB IDE environment.

Readme Files

For the latest information on using other tools, read the tool-specific Readme files in the

Readme subdirectory of the MPLAB IDE installation directory. The Readme files contain

updated information and known issues that may not be included in this user’s guide.

MPASM™ Assembler, MPLINK™ Object Linker, MPLIB™ Object Librarian User’s 

Guide (DS33014)

This user’s guide describes how to use the Microchip MPASM Assembler, the MPLINK 

Object Linker and the MPLIB Object Librarian.

dsPIC33FJ12MC202 PIM Information Sheet (DS70314)

This document provides device specific information for the dsPIC33FJ12MC202 PIM 

device. The dsPIC33FJ12MC202 is a high-performance 16-bit digital signal controller 

within a small 28-pin 6x6 mm QFN package.

dsPIC33FJ32MC204 PIM Information Sheet (DS70316)

This document provides device specific information for the dsPIC33FJ32MC204 PIM 

device. The dsPIC33FJ32MC204 is a high-performance 16-bit digital signal controller 

within a small 44-pin QFN package.

dsPIC33FJ128MC804 PIM Information Sheet (DS70326)

This document provides device specific information for the dsPIC33FJ128MC804 PIM 

device. The dsPIC33FJ128MC804 is a high-performance 16-bit digital signal controller 

within a small 44-pin QFN package.

dsPIC33FJ256MC710 PIM Information Sheet (DS70564)

This document provides device specific information for the dsPIC33FJ256MC710 PIM 

device. The dsPIC33FJ256MC710 is a high-performance 16-bit digital signal controller 

within a 100-pin TQFP package.

dsPIC33FJ12MC201/202 Data Sheet (DS70265)

This data sheet contains device specific information for the dsPIC33FJ12MC201/202 

Digital Signal Controller (DSC) Devices. The dsPIC33F devices contain extensive 

Digital Signal Processor (DSP) functionality with a high performance 16-bit 

microcontroller (MCU) architecture.

dsPIC33FJ32MC202/204 and dsPIC33FJ16MC304 Data Sheet (DS70283)

This data sheet provides device specific information for the dsPIC33FJ32MC202/204 

and dsPIC33FJ16MC304 motor control family of devices. 
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dsPIC33FJ32MC302/304, dsPIC33FJ64MCX02/X04, and dsPIC33FJ128MCX02/

X04 Data Sheet (DS70291)

This data sheet contains device specific information for the dsPIC33FJ32MC302/304, 

dsPIC33FJ64MCX02/ X04, and dsPIC33FJ128MCX02/X04 motor control family of 

devices.

dsPIC33FJXXXMCX06/X08/X10 Data Sheet (DS70287)

This data sheet contains device specific information for the dsPIC33FJXXXMCX06/

X08/X10 motor control family of devices. 

To obtain any of these documents, visit the Microchip web site at www.microchip.com.

THE MICROCHIP WEB SITE

Microchip provides online support via our web site at www.microchip.com. This web 

site is used as a means to make files and information easily available to customers. 

Accessible by using your favorite Internet browser, the web site contains the following 

information:

� Product Support – Data sheets and errata, application notes and sample 

programs, design resources, user’s guides and hardware support documents, 

latest software releases and archived software

� General Technical Support – Frequently Asked Questions (FAQs), technical 

support requests, online discussion groups, Microchip consultant program 

member listing

� Business of Microchip – Product selector and ordering guides, latest Microchip 

press releases, listing of seminars and events, listings of Microchip sales offices, 

distributors and factory representatives

DEVELOPMENT SYSTEMS CUSTOMER CHANGE NOTIFICATION SERVICE

Microchip’s customer notification service helps keep customers current on Microchip 

products. Subscribers will receive e-mail notification whenever there are changes, 

updates, revisions or errata related to a specified product family or development tool of 

interest.

To register, access the Microchip web site at www.microchip.com, click on Customer 

Change Notification and follow the registration instructions.

The Development Systems product group categories are:

� Compilers – The latest information on Microchip C compilers and other language 

tools. These include the MPLAB C18 and MPLAB C30 C compilers; MPASM™ 

and MPLAB ASM30 assemblers; MPLINK™ and MPLAB LINK30 object linkers; 

and MPLIB™ and MPLAB LIB30 object librarians.

� Emulators – The latest information on Microchip in-circuit emulators.This 

includes the MPLAB ICE 2000 and MPLAB ICE 4000.

� In-Circuit Debuggers – The latest information on the Microchip in-circuit 

debugger, MPLAB ICD 2.

� MPLAB® IDE – The latest information on Microchip MPLAB IDE, the Windows® 

Integrated Development Environment for development systems tools. This list is 

focused on the MPLAB IDE, MPLAB SIM simulator, MPLAB IDE Project Manager 

and general editing and debugging features.

� Programmers – The latest information on Microchip programmers. These include 

the MPLAB PM3 and PRO MATE II device programmers and the PICSTART® 

Plus and PICkit™ 1 development programmers.
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CUSTOMER SUPPORT

Users of Microchip products can receive assistance through several channels:

� Distributor or Representative

� Local Sales Office

� Field Application Engineer (FAE)

� Technical Support

Customers should contact their distributor, representative or field application engineer 

(FAE) for support. Local sales offices are also available to help customers. A listing of 

sales offices and locations is included in the back of this document.

Technical support is available through the web site at: http://support.microchip.com

DOCUMENT REVISION HISTORY

Revision A (June 2009)

This is the initial released revision of this document.
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Chapter 1.  Introduction

1.1 OVERVIEW

The Microchip dsPICDEM™ MCHV Development System is intended to aid the user in 

the rapid evaluation and development of a wide variety of motor control applications 

using a dsPIC® Digital Signal Controller (DSC). This development system is targeted 

to control Brushless DC (BLDC) motors, Permanent Magnet Synchronous Motors 

(PMSM), and AC Induction Motors (ACIM) in sensor or sensorless operation. 

This flexible and cost-effective tool can be configured in different ways for use with 

Microchip’s specialized Motor Control DSCs. The dsPICDEM™ MCHV Development 

System supports the dsPIC33F Motor Control device family, and offers a mounting 

option to connect either a 28-pin SOIC device or a generic 100-pin Plug-In Module 

(PIM). 

The system has a three-phase power module device that contains the motor inverter 

and the gate driver’s circuitry. The circuit drives a BLDC, PMSM, or ACIM motor using 

different control techniques without requiring any additional hardware. It also has 

Power Factor Correction (PFC) circuitry in order to provide a full set of tools used in 

motor control applications. Figure 1-1 provides a photograph of the dsPICDEM™ 

MCHV Development System. A block diagram that shows the main components of the 

system is provided in Figure 1-2.

The rated continuous output current from the inverter is 6.5A (RMS). This allows up to 

approximately 2 kVA output when running from a 208V to 230V single-phase input volt-

age in a maximum 30ºC (85ºF) ambient temperature environment. Therefore, the sys-

tem is ideally suited for running a standard 3-Phase Induction Motor of up to 1.4 kW 

(1.8 HP) rating or a slightly higher rated industrial servo-motor. The power module is 

capable of driving other types of motors and electrical loads that do not exceed the 

maximum power limit and are predominantly inductive. Furthermore, single-phase 

loads can be driven using one or two of the inverter outputs.

The unit is capable of operating from 90V up to a maximum of 265V. A more detailed 

explanation of power limitations is provided in Chapter 4. “Hardware”.

Note: It is recommended to carefully read the hardware section mentioned above 

before attempting to use the system.
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FIGURE 1-1: dsPICDEM™ MCHV DEVELOPMENT SYSTEM
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FIGURE 1-2: SYSTEM BLOCK DIAGRAM
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1.1.1 Features

The following are some of the key features of the dsPICDEM™ MCHV Development 

System.

Supported Devices:

� 28-pin to 100-pin dsPIC33FJXXXMC202 PIM (MA330014) with a dsPIC33F Motor 

Control device (U11) socket

� 44-pin to 100-pin dsPIC33FJXXXMCX04 PIM (MA330017 and MA330018) with a 

dsPIC33F Motor Control device (U11) socket

� 100-pin to 100-pin dsPIC33FJXXXMCX10 PIM (MA330013) with a dsPIC33F 

Motor Control device (U11) socket

� dsPIC33FJ12MC202 Motor Control device in a SOIC package (U12) footprint

Motor Control Interfaces:

� Three-phase inverter bridge with a power rating of 400V/6.5A (J17)

� Hall sensors/Quadrature Encoder Interface (QEI) for sensored motor control 

algorithms (J9)

� Phase voltage feedback for sensorless BLDC operation

� DC bus current sense resistor for single shunt vector control

� Phase current sense resistor for dual shunt vector control

� Overcurrent protection

Input/Output Control Switches:

- One isolated push button (S1)

- Isolated reset push button (RESET)

- Isolated 10 k potentiometer (POT1)

- LED indicator for PWM outputs

Isolated Communication Ports:

- UART communication via USB (J6)

- UART communication via RS-232 (J8)

Built-In Isolated Programmer/Debugger (J20):

- Starter Kit-type programmer/debugger (daughter card)

Power Supply Connectors:

- Power Tab Fast-On connectors (BP1 and BP2) for the power stage

- Auxiliary 24V power input connector (J15) for the dsPIC DSC device and 

low-power circuitry (non-populated)

- Auxiliary 15V and 3.3V regulators for regulating auxiliary power supply 

(non-populated)

Programming Connectors:

- ICSP™ connector for programming a dsPIC DSC device (J18), non-isolated

- ICSP connector for programming the PIC18LF2450 USB module to the UART 

Bridge (J1), isolated

- ICSP connector for programming the Starter Kit Programmer/Debugger 

(SKDE), isolated PIC18F67J50 (J4)
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Power Factor Corrector:

- Maximum input voltage 90 VAC-265 VAC

- Current Feedback circuitry

- VAC input voltage sensing

- Zero-crossing detection

- DC bus sensing

- Overcurrent protection (The maximum power available is specified in 

Section 4.3 “Electrical Specifications”.)

Built-In Power Supplies:

- 15V power supply, maximum power available 11W

- 3.3V power supply, maximum power available 2W

Additional Protection Circuitry:

- 250 VAC/15A fuse

- In-rush current limiter

- EMI filter
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Chapter 2.  Getting Started

2.1 BOARD COMPONENTS

The dsPICDEM™ MCHV Development System comprises two stages:

� PFC Stage

The first stage is integrated by the Power Factor Correction (PFC) circuitry, the 

full-bridge rectifier, the 15V power supply, and the 3.3V power supply.

� Power Module Stage

The second stage is the power module board. This board contains the dsPIC DSC 

connector, the isolated user interface connectors, and the motor drive.

Figure 2-1 shows an interior view of the system.

FIGURE 2-1: dsPICDEM™ MCHV DEVELOPMENT SYSTEM
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2.2 USER INTERFACE

The dsPICDEM™ MCHV Development System has the following components to 

interact with the user. Figure 2-2 shows a photograph of the front of the system. 

� Input/Output Control Switches (Figure 2-2):

- One isolated push button (S1)

- Isolated reset push button (RESET)

- Isolated 10 kΩ potentiometer (POT1)

- LED indicator for PWM outputs

� PWM Outputs (Figure 2-2)

- Enable and disable jumpers (J7)

� Isolated Communication Ports (Figure 2-2):

- UART communication via USB (J6)

- UART communication via RS-232 (J8)

- Communication Ports Selector (J2, J3)

� Built-In Isolated Programmer/Debugger (Figure 2-2)

- Starter Kit type programmer/debugger (J20)

� Motor Connectors (Figure 2-3):

- Three-phase inverter bridge connector with a power rating of 400V/6.5A (J17)

- Hall sensors/Quadrature encoder interface for sensored motor control 

algorithms (J9)

� Power Supply Connector (Figure 2-4)

- AC power inlet specified for 40VAC-220VAC 10Amps max (J1)

FIGURE 2-2: dsPICDEM™ MCHV DEVELOPMENT SYSTEM (FRONT)
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FIGURE 2-3: dsPICDEM™ MCHV DEVELOPMENT SYSTEM (LEFT SIDE)

FIGURE 2-4: dsPICDEM™ MCHV DEVELOPMENT SYSTEM (RIGHT SIDE)

2.3 CONNECTING THE SYSTEM

2.3.1 Power Connections

It is recommended that cables used for the power connections should be terminated 

with blue or red insulated crimp terminals. If crimp terminals are not used, care should 

be taken to ensure that stray strands of wire do not short to adjacent terminals or the 

enclosure. If possible, all wires should be stripped and tinned with solder before 

connecting to the dsPICDEM™ MCHV Development System terminals.

CAUTION

The user must be aware of the operating procedures outlined below and ensure that 

they are followed. Failure to do so may result in damage to the system.

J1

3-Phase Inverter
Bridge Connector

Hall Sensors/
QEI Connector
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For the AC mains supply input, standard double-insulated, 3-core flex cable should be 

used with a minimum current rating of 10A (1 mm2 18 AWG). A computer power cable 

can be used.

The recommended output cable size is 1.0 to 1.5 mm2 (18-16 AWG) and it should have 

a 600V rating. This cable should also be double insulated or have a protective ground 

screen. Access to the terminal screws is provided via holes in the lid of the enclosure. 

A slotted screwdriver should be used.

Figure 2-6 provides the locations of all connectors. Corresponding tables that describe 

each connection are provided in the relevant section.

FIGURE 2-5: dsPICDEM™ MCHV DEVELOPMENT SYSTEM CONNECTIONS

The power connections are listed in Table 2-1.

Note: The system is designed for installation category II. Therefore, the incoming 

mains cable should be wired into a standard non-locking 2-pin in addition 

with a earth ground type plug.

Note: The user should only access the power terminals when the system is fully 

discharged (see the “Safety Notice” on page iii).

1
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TABLE 2-1: POWER CONNECTIONS

2.3.2 Host/Communication Connections

A mini-USB-to-USB certified cable and a standard DB9 male-to-female cable should 

be used to connect the dsPICDEM™ MCHV Development System to the host 

computer.

The communication port connectors are listed in Table 2-2. Refer to Figure 2-5 for their 

exact location.

TABLE 2-2: COMMUNICATION PORT CONNECTORS

2.3.2.1 CONNECTION SEQUENCE

The recommended connection sequence is listed below. The user should ensure that 

the following sequence is met before connecting the system to the mains, a motor and 

a host computer.

1. Connect the motor terminals R, Y, and B (also known as RWB or 123 or ABC) to 

the connection nodes M1, M2, and M3 (4, 5, and 6 in Figure 2-5), respectively.

2. Follow the next steps if position sensors are utilized to control the motor. If not, 

proceed to step 3.

a) If the motor position is sensed with Hall Sensors, connect the terminals A, B, 

and C to the connection nodes HA, HB, and HC (7, 8, and 9 in Figure 2-5), 

respectively. Also, connect the positive terminal +5V to the connection node 

+5V and the ground terminal to the connection node GND (10 and 11 in 

Figure 2-5).

b) If the motor position is sensed with a Quadrature Encoder, connect the ter-

minals phase A, phase B, and Index to the connection nodes HA, HB, and 

HC (7, 8, and 9 in Figure 2-5), respectively.

Number Name Type

1 Neutral Input

2 Earth Ground Input

3 Live (Fused) Input

4 Motor Phase 1 (M1) Output

5 Motor Phase 2 (M2) Output

6 Motor Phase 3 (M3) Output

7 Hall Sensor A (HA) Input

8 Hall Sensor B (HB) Input

9 Hall Sensor C (HC) Input

10 Hall Sensors, 5V power supply terminal Output

11 Hall Sensors, Ground terminal Output

Number Name Type

12 USB-to-UART connector Input/Output

13 RS-23- to-UART connector Input/Output

14 USB connector for the Starter Kit programmer/debugger Input/Output

15 Non-isolated ICSP™ connector for device programming/debugging Input/Output

Note: Before making any connection, verify that the system is not powered and it 

is fully discharged. The system is completed discharged when the red LED 

D13 is OFF.
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3. Connect the communication ports. 

a) If R-S32 communication is used, connect the DB9 male connector to the 

RS-232 port. Connect the other end to the host PC (12 in Figure 2-5).

b) If USB communication is used, connect the mini-USB male terminal to the 

mini-USB female connector labeled “USB” (12 in Figure 2-5). Connect the 

other end to the host PC.

4. Connect the SKDE cable. Connect the USB cable to the mini USB female 

connector labeled “Program/Debug” (14 in Figure 2-5). Connect the USB male 

terminal to the USB ports of the host PC.

5. Power Cord connection. Make sure the power cord is disconnected from the AC 

mains before connecting the female terminal of the power cable to the AC input 

connector (1, 2, and 3 in Figure 2-53) of the dsPICDEM™ MCHV Development 

System.

Note: The Microchip serial emulator driver (mchpcdc.inf) should be installed on 

you PC in order to activate the USB-to-Serial emulator. The emulator driver 

is contained in the CD shipped with the dsPICDEM™ MCHV Development 

System.

Note: The built-in programmer/debugger is supported in MPLAB IDE 8.33 or 

higher.

Note: The unit is designed to be connected to the AC mains supply via a standard 

non-locking plug. As the unit has no mains switch, this plug constitutes the 

means of disconnection from the supply. Therefore, the user must have 

unobstructed access to this plug during operation.
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2.4 POWER SEQUENCES

The user should ensure that the following power sequences are adhered to.

2.4.1 Power-up Sequence

The unit is powered-up when the power cable is connected to the AC mains. To verify 

that the unit is powered make sure that the LEDs D6, D13, D17 and D18 are ON.

2.4.2 Power-down Sequence

1. Stop firing all power devices by removing the PWM OUTPUTS shunt jumper.

2. Turn OFF the incoming AC supply by disconnecting the power cord from the 

mains.

3. Wait until the red DC bus LED indicator (D13) located next to the DC bus P 

connector has gone out (this will take 5 minutes or less).

2.4.3 Programming/Debugging an Application Code Using the 

Built-in Starter Kit Programmer/Debugger

The MPLAB Starter Kit Programmer/Debugger for the dsPICDEM™ MCHV Develop-

ment System may be used with MPLAB IDE, the free integrated development environ-

ment, which is available from Microchip’s web site (www.microchip.com). MPLAB IDE 

allows the Starter Kit to be used as an in-circuit debugger as well as a programmer for 

the following devices.

� dsPIC33FJ12MC202

� dsPIC33FJ32MC204

� dsPIC33FJ128MC804

� dsPIC33FJ256MC710

In-circuit debugging allows you to run, examine and modify your program for the device 

embedded in the Starter Kit hardware. This greatly assists you in debugging your 

firmware and hardware together.

Special Starter Kit software interacts with the MPLAB IDE application to run, stop, and 

single-step through programs. Breakpoints can be set and the processor can be reset. 

Once the processor is stopped, the register’s contents can be examined and modified.

For more information on how to use MPLAB IDE, reference the following 

documentation:

� “MPLAB IDE User’s Guide” (DS51519)

� “MPLAB IDE Quick Start Guide” (DS51281)

� MPLAB IDE Online Help

2.4.4 Setting Up an Application for Debug

To prepare the application for debug:

1. Launch MPLAB IDE, and then open the application project. The related work-

space will be open. For information on projects and workspaces, see the MPLAB 

IDE documentation mentioned at the beginning of this chapter.

2. Select Project>Build All to build the application code. The build’s progress will be 

visible in the Build tab of the Output window.

Note: The unit is designed to be connected to the AC mains supply via a standard 

non-locking plug. As the unit has no mains switch, this plug constitutes the 

means of disconnection from the supply and thus the user must have 

unobstructed access to this plug during operation.
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